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Create a Polished Raised Type Treatment
Tutorials | August 12Th, 2010

If you have read some of my other type tutorials, you know I love the Appearance panel. This tutorial is no different. 
Using the Appearance panel, some gradients, and transforms, you can create a polished lifted type treatment. Using the 
Appearance panel makes it super easy to apply the treatment to other fonts and vector elements.

Final Image
Below is the final type treatment we will be working towards.
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Program : Adobe Illustrator CS5
Difficulty: Intermediate
Topics Covered: Appearance Panel
Estimated Completion Time: 15-20 minutes

Step 1
In a new document, use the Rectangle tool (M) to create a rectangle the size of your document and fill it with a gray 
color. Having a background color from the beginning will make it easier to see the changes we will be making to the text.

Step 2
With the Type tool (T), type out some text. Mine is around 100pt for big header text, but you can adjust the text to fit 
your needs. Next, remove any fill and stroke from the text, we will be directly adjusting these in the Appearance panel.

Step 3
With the text selected, choose Add New Fill from the pop-up menu of the Appearance panel. Change the new fill to a 
linear gradient with the first color stop white and the second a light gray. From the Gradient panel change the Location of 
the first white color stop to 40 and change the Angle to -90.

http://www.anrdoezrs.net/click-3751719-10503029?url=http://www.adobe.com/products/illustrator/




Step 4
From the Appearance panel, create a new fill like in the previous step, fill it with white, and make sure the white fill is 
below the first gradient in the Appearance panel. Select the white fill in the list and go Effect > Path > Offset Path. In the 
Offset Path dialog change the Offset to 1 px. With the white fill still selected in the Appearance panel list, go Effect > 
Distort & Transform > Transform. In the Transform Effect dialog, change the Vertical Move to 1 px.



Step 5
From the Appearance panel, select the white fill, and press the Duplicate Selected Item button at the bottom of the 
panel. Select the bottom copy and fill it black. Expand the attributes on the fill by pressing the small arrow to the left of 
the fill thumbnail if it is not expanded already. Click on Transform to open the Transform Effect dialog and change the 
Vertical Move to 2 px.



Step 6
Duplicate the black fill like in the previous step and change the fill to a linear gradient. Add two more color stops to the 
linear gradient and change the first to black, the second to a dark gray, the second to a slightly lighter gray than the 
second, and the fourth to a gray slightly darker than the second. Next, change the Angle to -90.





Step 7
Expand the attributes of the new linear gradient in the Appearance panel, and click on the Transform Effect. With the 
Transform Effect dialog open, change the number of Copies to 10 and the Vertical Move to 1 px.

Step 8
With the four color stop gradient fill still selected in the Appearance panel, go Effect > Stylize > Drop Shadow. In the 
Drop Shadow dialog, change the Opacity to 100, the X Offset to 0, the Y Offset to 2, and the Blur to 2. That is pretty 
much it!



Step 9
You can save the treatment as a Graphic Style to easily apply to other type and vector objects. Simply select your text 
and press the New Graphic Style button in the Graphic Style panel. Now press the new graphic style with any object to 
apply the style. Pretty cool!



Final Image
At this point you can make the treatment better by jazzing up the background with some grain textures and simple 
offsets to other text.



      

68 Responses to “Create a Polished Raised Type Treatment”

1.  Joshua Johnson

says:

August 12, 2010 at 7:48 am 

I bow to your use of the appearance palette sir. Really stellar work!
Reply

2.  Alexandre Giesbrecht
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says:

August 12, 2010 at 8:29 am 

I tried to do it on CS3, and I guess the biggest difference is that Illustrator CS3 won’t allow me to use pixels as a 
unit.
Reply

◦  Derek
says:

August 31, 2010 at 2:04 pm 

If you want pixels as a unit, Type px after the number. Ex: 1 px = 1 pixel
Reply

◦  Tyler
says:

October 23, 2010 at 6:50 pm 

I used points as a unit rather than pixels, and I still got the same result. I have CS5 though, so I’m not sure.
Reply

◦  Milos Milovanovic
says:

January 15, 2012 at 6:27 pm 

Same…
Reply

3.  Lyell Rodieck
says:

August 12, 2010 at 9:43 am 

Help! I had trouble with this tutorial. I’m using CS4; are you perhaps using CS5? I could come close to your 
example if I used negative numbers. instead of positive, on the vertical transforms, but I couldn’t figure out how to 
apply a drop shadow. Such a lovely type style you’ve developed, and I would so like to be able to recreate it!
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4.  Neri Ribeiro

says:

August 12, 2010 at 12:40 pm 

Muito bom o tutorial!!! Fiz aqui no CS5 e deu tudo certo!!!! Vale a pena fazer esse tutorial!!!
Reply

5.  Mohit Dhiman

says:

August 12, 2010 at 1:51 pm 

I am using CS4 and i didn’t even came closer to something like this. Have you done this on CS5, please help.
Reply

◦  Rawly
says:

August 15, 2010 at 12:38 am 

“Tutorial Details
Program : Adobe Illustrator CS5
Difficulty: Intermediate
Topics Covered: Appearance Panel
Estimated Completion Time: 15-20 minutes”
right under the main picture….
Reading goes a long way.
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6.  hoshimo

says:

August 12, 2010 at 5:26 pm 
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haha sweet!
Reply

7.  Alias_Matlock
says:

August 12, 2010 at 7:48 pm 

This is pretty sweet. And I don’t wanna be an ass people, but if you actually read from top to bottom, he says what 
version he is using. Now go read again!
Reply

8.  will creare

says:

August 13, 2010 at 1:04 am 

This is amazing. nice work. I love the fact you can apply it to anything once its made. just a shame i don’t have 
CS5 yet.
Reply

9.  karasu
says:

August 13, 2010 at 4:04 am 

I’m using CS3 and the only “impossible” step is the “offset path” one. The result is quite the same ^_^
Reply

10.  Ondra
says:

August 13, 2010 at 5:08 am 

Hiay, thanks a lot. It looks great! 
I did it in CS2, I’m pretty sure you’ll be able to do it in CS1 as well… 
Love it
Reply
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11.  neunen
says:

August 13, 2010 at 7:45 am 

oh that’s a nice one!
Reply

12.  software outsourcing

says:

August 13, 2010 at 9:19 am 

This is absolutly adorable work!
Thanks  
Reply

13.  With Russia From Love
says:

August 13, 2010 at 10:44 am 

You are the best! Low bow
Reply

14.  tutorial blog

says:

August 13, 2010 at 7:43 pm 

very nice. Thank for tutorial
Reply

15.  Matthias Scheel
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says:

August 14, 2010 at 1:41 am 

awesom! thanks!
Reply

16.  Jason Roberts

says:

August 15, 2010 at 8:24 am 

This is Great!
Thanks for the new Graphic Style!
Reply

17.  Shane

says:

August 16, 2010 at 3:36 am 

This looks like an awesome tut!! Can’t wait to try it out!!
Thanks.
Reply

18.  K Khalifa

says:

August 16, 2010 at 9:12 am 

Cool technique– thanks! I had no problems doing in CS4– just had to change the vertical offsets to negative values 
to get the required angle.
Reply
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August 20, 2010 at 3:10 pm 

Precisely…I did the same thing and created two styles, one for a top offset and one for a bottom offset..
Reply

19.  Brian
says:

August 17, 2010 at 7:19 am 

Great tut. Another weapon in my arsenal!
Reply

20.  Theo Hodkin

says:

August 17, 2010 at 3:05 pm 

Saw a tutorial on how to create something similar in plain CSS3… but this looks way better!
Reply

21.  Dany
says:

August 18, 2010 at 9:33 am 

Thanks a lot, worked perfectly in my CS4, just had the volume or shadow effect upside down, but it isnt that 
important, looks as cool!
Reply

22.  Antor

says:

August 22, 2010 at 3:54 pm 

Really cool man!!! That’s a tight text effect!
Reply
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23.  fatcoala
says:

September 9, 2010 at 12:37 am 

很好，很喜欢，太厉害了！GOOD！

Reply

24.  Bruno

says:

September 23, 2010 at 3:57 pm 

Just amazing! Thank you for all the help that you give to all us  
Reply

25.  Flo
says:

October 9, 2010 at 1:06 am 

How did you do the step 2 ^^’ ?
Reply

◦  Alexander

says:

October 26, 2010 at 4:03 am 

Just remove the colors for fill and stroke like so: http://grab.by/73Id
Reply

26.  Alexander
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says:

October 26, 2010 at 4:02 am 

I managed to do this in CS3 as well, just had to change the vertical offsets to negative values (as most of you) to 
get the proper result. 
Be sure to read the tutorial throughly and compare your result to every step in the tutorial and you should be just 
fine. 
Got this result: http://grab.by/73I9
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27.  Tony
says:

November 26, 2010 at 2:26 am 

so cute~~!!!真喜欢〜～〜～〜～
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28.  Junqui

says:

December 6, 2010 at 9:58 am 

Thanks sharing your knowledge. Your tutorials are just great!!!!
Reply

29.  lnw
says:

December 8, 2010 at 11:42 pm 

Just change unit at Edit>Preferences>Units & Display Performance
Change unit in General Box.
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December 14, 2010 at 7:58 am 

interesante
Reply

31.  dong
says:

January 5, 2011 at 2:59 am 

organize file give me!!
Reply

32.  Parasar
says:

March 4, 2011 at 12:48 am 

Thanks for this amazing VECTIP!
Reply

33.  IvanErshov
says:

March 8, 2011 at 5:56 am 

Awesome
Reply

34.  IvanErshov
says:

March 8, 2011 at 6:48 am 

step 7 mistake – not 1 px vertical move, but -1px.
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35.  Shweppsy
says:

April 2, 2011 at 4:00 pm 

Thanks !!!
The Best !!! ( my one wasnt exacly from the first time but it’s look cool)
Reply

36.  CreativeJH

says:

April 9, 2011 at 2:07 pm 

It’s clean and nice work !
I’ll try it  
Reply

37.  Akhtar Raza
says:

April 18, 2011 at 9:05 am 

Can any one help me ?
where is appearance panle option in photoshop cs5.
Reply

◦  Cory
says:

July 3, 2011 at 6:44 pm 

This tutorial is for Illustrator, not Photoshop.
Reply
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says:

April 25, 2011 at 5:46 am 

thanks so much!
Reply

◦  marc
says:

May 9, 2011 at 9:14 am 

hey looks good, but im wondering how you did that fine lines in the final result, is there any effect you used, 
the look kinda 3d’ish.
thanks
marc
Reply

39.  Braden
says:

June 2, 2011 at 9:04 pm 

Ok, I’m not sure why, but I don’t think that when I made it that it looked the same… Any thoughts? What did I do 
wrong?
[IMG]http://i56.tinypic.com/348534k.png[/IMG]
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◦  Braden
says:

June 2, 2011 at 9:04 pm 

http://tinypic.com/r/348534k/7
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40.  Angielski Wrocław

says:
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June 5, 2011 at 1:45 pm 

Great effect. Is this possible to make it in photoshop cs5 as well?
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41.  Guylaine
says:

June 20, 2011 at 3:33 pm 

I so enjoyed it.
Reply

42.  Cory
says:

June 30, 2011 at 10:57 am 

Just saved my skin on a logo I’m working on — this fits absolutely perfect! Thanks.
Reply

43.  Mohammed Maqsood
says:

July 21, 2011 at 8:20 am 

Hi!
I liked it
This technique is very good for Text Effects! Can you post the same technique using any logo.
Reply

44.  terapon
says:

July 28, 2011 at 8:16 pm 

very nice!
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45.  Michael
says:

August 19, 2011 at 12:26 pm 

Really great work, Once again brilliant use of the appearance panel.
Reply

46.  FatBrush
says:

August 21, 2011 at 6:37 pm 

I’m stomped, when I try to do the offset path the command menu is as if that function does not apply in other word 
the offset path function is not hihglited and it does not work.
What am I doing wrong? HELP…
Reply

47.  Lien Nguyen

says:

October 8, 2011 at 5:37 pm 

Hi, I was wondering what font did you use for the “Vectips” lettering in Step 9? I love the cursive font but can’t find 
it on my Illustrator
Reply

48.  Gez

says:

October 30, 2011 at 3:23 am 

Thanks for this. I was just designing a logo for somebody and running out of ideas. I just applied this effect to one 
of the designs and they approved it! The best thing about it is when they wanted the logo text to be changed I 
didn’t have to redo the whole thing from scratch like I used to. As it’s editable I just retyped it out. Fantastic!
Reply
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49.  Hunny

says:

November 1, 2011 at 9:07 am 

I’m curious to find out how did you do the smaller font, can you provide a tutorial for that please?
Reply

50.  n0ltr0n
says:

December 4, 2011 at 5:16 pm 

Awesome tutorial. As a novice in illustrator, this is a very helpful tut.
Reply

51.  Manuel
says:

December 16, 2011 at 8:39 am 

Wonderful. Good tutorial.
Reply

52.  Toni
says:

January 24, 2012 at 11:17 am 

Good Day
As a beginner in Ai I have to say your tutorial was more then perfect I had no problem following your directions and 
I thank you for taking the time to help us learn.
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February 11, 2012 at 8:51 pm 

this looks great and easy to follow! thank you! helped a lot creating a logo.
Reply

54.  Elaine
says:

February 13, 2012 at 7:24 pm 

I want to put you in my toolbox.. or back pocket whichever is more comfortable.. genius, tutorial in layman terms, I 
easily followed in CS3, got same result as guys above.. top offset rather than below but proved I could play around 
a bit & achieve several effects. I want more…
Reply

55.  Bea
says:

March 27, 2012 at 2:58 pm 

This is a great Tutorial! Thank you so much! Came out perfect  
Reply
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